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1. GETTING STARTED 
1.1 Requirements 

Pentium PC 150 MHz or higher with 16 MB RAM (32 MB recommended), HiColor graphics card, CD-
ROM drive and a SoundBlaster compatible sound card with microphone and speakers. Microsoft 
Windows 95/98, Windows 2000, Windows XP. 

1.2 Change Default Settings 
If you want to change the default settings, select Settings from the Extras menu. In the Settings 
dialogue box, you can change the following default settings: 

Default language: Language of the menu bar, status bar, and on-screen help. • 

• 

• 

Learner data directory: Directory where the learner data is saved (default directory for learner data 
is C:\TEMP). 

Data directory: Directory which is shown when you open a learning package. 

 
Default Settings 

It is necessary to restart the program in order to activate the new settings. 
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2. TELOS LANGAUGE PARTNER (TLP Viewer) 
With the TLP Viewer you can run learning packages that have been created with TLP Pro, TLP Light, 
or TLP Basic (for more information on TLP Pro, see chapter 3.) 

2.1 GENERAL FUNCTIONS 

2.1.1 Open a Learning Package 
 

To open a learning package, click on ”Open a Learning Package” (or select the command Open from 
the File menu), access the CD drive, select a learning package (file with extension *.DIA), and click 
OK. 

 
 Opening Page 

This will take you to the Contents page of the chosen package, listing all the exercises contained in 
the package. 

 
 Contents page 

You can open and close the displayed folders and exercises of the Contents page with a double-click. 
Select an exercise of your choice and open it with a double-click, or click on OK. 
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 The Contents page can always be accessed by clicking the Telos button. 

 If an exercise consists of more than one page, access the exercise via the Contents page 
(using the Telos button), and then use the Forward and Backward buttons to navigate 
between the different pages of an exercise. 

2.1.2 Close a Learning Package 
To close a learning package, select the Close command from the File menu. 

2.1.3 Exit the Program 
To exit the program, select the Exit command from the File menu. 
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2.1.4 Menu Bar 
The menu bar displays the following main functions: File, Edit, Extras, Language, Help. 

File: 

Open Opens an existing package. 

Close Closes a package. 

Exit Closes the program. 

Extras: 

Notepad Opens the TLP-Notepad. 

Special 
Characters 

Opens Special Character box. 

Dictionary Opens a dictionary. 

Settings Opens box for changing default settings (language, opening tune, directory for 
learner data). 

Sound Data 
Format 

Opens box for changing the sound recording quality. 

Language: 

The Language menu enables you to change the language of the menu bar, status bar, and on-screen 
help. 

Help: 

Help Accesses the Help function. 

History Accesses the History function, which provides an overview of all the pages you 
have worked with during a particular learning session. 
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2.1.5 Tool Bar 
The tool bar includes push buttons and drag&drop buttons. 

To perform an action associated with a push button, you simply click on the button. 

To execute a command assigned to a particular drag&drop button, click on the button, drag it to the 
desired destination, and release it. The drag&drop function works with the majority of fields on a 
screen at any given time. If you drag a button to an undefined field, you will hear a beep. 

Push Buttons 
With the push buttons, you can perform the following actions: 

 Open the Contents page of a learning package 

 Go to the next dialogue page 

 Go to the previous dialogue page 

 Stop recording or playing sound 

 Show/hide hyperlinks 

 Open text field with prompts concerning a given task 

 Save text as text file 

 Show score 

 video/sound operation panel: 

 Start video/sound clip 

 Pause video/sound clip 

 Drag the Slide button to the left or right, to move the video/sound clip to a desired 
position. 

 Stop video/sound clip. 
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Drag&Drop Buttons 
The following actions can be performed with drag&drop buttons: 

 Listen to the auditory model 

 Record yourself 

 Listen to your recording 

 Erase and/or enter text 

 Show text 

 Check the exercise 

 Show a solution 

 Show a translation 
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2.1.6 Special Characters 
Select Special Characters in the Extras menu to open the Special Character dialogue box. Select a 
character and click on Paste in order to enter it into your text. 

2.1.7 Sound Recording Quality 
If you want to change the sound recording quality, select Sound Data Format from the Extras menu. 

 

2.1.8 Help Facilities 
The program provides an on-screen help facility. To access the help option, select the corresponding 
command from the Help menu. 

Use the Contents menu, the Previous or History buttons in order to navigate through the help facilities, 
or click on the green underlined key words for further information. 

To close the on-screen help function, select Exit from the File menu of the help window. 

2.1.9 History 
Via the Help menu, you can also access a History, which provides an overview of all the pages you 
have viewed during a learning session.  

You can open a page by clicking on the title in the History. 
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2.2 PRACTICE AND LOOK-UP ACTIVITIES 
NOTE: This manual covers all types of exercises that can be created with TLP Pro. The learning 
package on your CD ROM or other learning packages provided by your tutor may only include some 
of these exercises. 

Using the on-screen help facility, you can also access the appropriate help directly from within an 
exercise. 

2.2.1 Dialogue Exercises 
There are two types of dialogue exercises providing the same practice functions, one with ”head 
pictures” (or names) for 2 speakers, and another one with a ”situation picture” and balloons for up to 5 
speakers. 

 
 Dialogue Exercise with ”Head Pictures” 

 
 Dialogue Exercise with ”Situation Picture” 
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How to Do a Dialogue Exercise 

The following recommendations will help you to make good use of the flexible practice opportunities of 
the dialogue exercises. In the section directly after these recommendations, the functions of the 
buttons will be explained and you will learn how to perform the different practice activities. 

Listening to the dialogue 

Hide the text and listen to the dialogue (or parts of the dialogue) as often as desired. Try to 
understand as much as you can without the support of the written text. 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

Make the dialogue text visible and listen again. Use the text in order to enhance your 
understanding of the dialogue.  

Look-up 

Look up words. 

Listen to and/or read the dialogue with the simultaneous support of the written translation (if 
available) to ensure that you fully understand the dialogue. 

Activate hyperlinks (if the Hyperlink button is activated) and open linked explanations or 
exercises. 

Use the TLP-Notepad for taking notes and writing down new words and phrases. 

Listening and Recording 

Listen to the speaker turn of your choice. 

Repeat and record the passage. 

Compare your recording with the model. 

Repeat the recording process until you are satisfied with your performance. 

Writing 

Erase the dialogue. Listen to a section and enter what you heard into the corresponding field. 

Compare what you have written with the model by dragging the Solution button to the field in 
question. 

Erase individual or all dialogue sections and try to write them out again, this time without listening 
to the model. 

Role-play 

Take over one role in the dialogue and record yourself. 

Listen to your recording. 

Compare the recording with the model. 

Repeat the role play until your performance is fluent and you are satisfied with the result. 

Try the role-play again, but this time without the help of the text representing your part of the 
dialogue. 

In the following paragraphs, you are shown how to perform the different practice activities. The 
practice buttons are drag&drop buttons. To execute a command assigned to a particular drag&drop 
button, drag the button to the desired field and release it. If you drag a button to an undefined field, 
you will hear a beep. 
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Listening and recording 

 You can listen to the whole dialogue, to one of the speaker turns, or to one of the two 
dialogue roles by dragging the Model Play button to the corresponding field: 

to listen to the whole dialogue, drag the button to the background field (or situation picture); • 

• 

• 

to listen to a speaker turn, drag the button to the corresponding turn field; 

to listen to a dialogue role, drag the button to the corresponding role field. 

 You can record yourself by dragging the Record button to the dialogue section you want to 
record: 

to speak & record a speaker turn, drag the button to the corresponding turn field; • 

• to speak & record a dialogue role, drag the button to the corresponding role field or to the head of 
the respective dialogue partner. 

Speak into the microphone when the Stop button appears in the tool bar. Click on the Stop button 
when you have finished your recording. 

 You can listen to your recording by dragging the Learner Play button to the dialogue section 
you want to listen to: 

to listen to your recording of a speaker turn, drag the button to the corresponding turn field; • 

• 

• 

to listen to your recording of a dialogue role together with model utterances, drag the button 
to the corresponding role field or to the head of the respective dialogue partner in a situation 
picture (when the dialogue is illustrated by a ”situation picture”); 

to listen to all your recordings, drag the button to the background field or to the situation picture. 

NOTE: If you are not satisfied with the sound quality, optimise the settings in the audio mixer of your 
sound card. 

Hide and show dialogue text 

 You can hide the dialogue text by dragging the Erase & Write button to the dialogue 
section you want to hide: 

to hide the whole dialogue, drag the button to the background field or to the picture (in cases 
where the dialogue is illustrated by a situation picture);  

• 

• 

• 

• 

to hide a speaker turn, drag the button to the corresponding turn field; 

to hide a dialogue role, drag the button to the corresponding role field or to the head of the 
respective dialogue partner. 

You can now listen to the relevant dialogue section without the dialogue text being shown and then 
write the dialogue text into the empty text fields. 
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 You can make the dialogue text visible again by dragging the Eye button to the dialogue 
section of choice: 

to show the whole dialogue text, drag the button to the background field or to the picture (in cases 
where the dialogue is illustrated by a situation picture);  

• 

• 

• 

to show the text of a speaker turn, drag the button to the corresponding turn field; 

to show the text of a dialogue role, drag the button to the corresponding role field or to the head of 
the respective dialogue partner. 

Write and compare with model 

 You can enter your text into a field by dragging the Erase & Write button into a turn field, or 
by clicking onto the corresponding field. 

 You can compare what you wrote with the model dialogue by dragging the Solution 
button to the dialogue section you wrote: 

to compare a speaker turn, drag the Solution button to the corresponding turn field; • 

• to compare the whole dialogue, drag the button to the background field or to the picture (in cases 
where the dialogue is illustrated by a situation picture). 

The solution, i.e. the model dialogue, will appear in a field above the dialogue. 

Access a translation 

 If the Translation button is activated, you can access a written translation to ensure that you 
fully understand the dialogue. Drag the Translation button to the dialogue section for which 
you want to see a translation; the translation will appear in a field above the dialogue. 

Activate hyperlinks 

 If the Hyperlink button is activated, certain words or passages in the text or dialogue, so-
called hotwords, will be linked to explanations or exercises. Click on the Hyperlink button in 
order to activate the hotwords. 

If you move the mouse over a hotword, the title of the page linked to the hotword will be displayed 
under the title of the current page. 

If you click on the hotword, the explanation or exercise that is linked to the hotword will be displayed 
and a Back button will appear on the screen. 

The Back button will take you back to the page containing the hotword. 

Look up words 
If a dictionary has been linked to your package, you can look up words by clicking on a word with the 
right mouse button (see also chapter 2.2.9 Access a Dictionary). 
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2.2.2 Text Comprehension Exercises 
The general purpose of the text comprehension exercises is to understand the presented text. 

 
 Text Comprehension Exercise with Visual Aid 

Listen to the text without support of a transcript 

 To listen to the text, drag the Model Play button to the grey field on the right. 

Listen to the text with support of a transcript 

 To show the transcript, drag the Eye button to the grey field on the right. You can now listen 
again to the whole text or to particular parts of the text. 

You can now listen to the whole text or to particular parts of the text as often as desired. 

 To listen to the text or a text passage, drag the Model Play button to the beginning of the text 
or to the text passage you want to start with. 

Speak and record the text 

 If you want to record the text, drag the Record button to the text passage you want to start 
with. 

 Speak into the microphone when the Stop button appears in the tool bar. Click on the Stop 
button each time you have finished recording a highlighted text passage. Click on Cancel in 
order to interrupt the recording. 

Compare recording with model 
Listen to the model and to your recording in order to compare your recording with the model. 

 To listen to your recording, drag the Learner Play button to the text passage you want to 
listen to. Click on the Stop button in order to stop the playback. 
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 To compare your recording with the model, drag the Model Play button to the text passage 
you want to listen to. Click on the Stop button in order to stop the playback. 

Access a translation 

 If the Translation button is activated, you can access a written translation of the text to 
ensure that you fully understand the text. Drag the Translation button to a text passage. The 
translation will appear in a text field on the top of the page. 

Activate Hyperlinks and Look up Words 

 If the Hyperlink button is activated, certain words or passages in the text or dialogue, so-
called hotwords, will be linked to explanations or exercises. Click on the Hyperlink button in 
order to activate the hotwords (see also Activate Hyperlinks in chapter 2.2.1). 

If a dictionary has been linked to your package, you can look up words by clicking on a word with the 
right mouse button (see also chapter 2.2.9 Access a Dictionary). 
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2.2.3 Video Exercises 
Video exercises are based on a video clip, which will usually be accompanied by a transcript. In 
addition, comprehension may be supported by a translation or by an internal dictionary and there may 
be hyperlinks to explanations or exercises. 

 
 Video Exercise 

Play the video 
To operate the video, you can use the Play, Pause, Stop and Slide button in the video operation panel 
underneath the video, or the Model Play button in the tool bar. 

 
 video operation panel 

 Click the Play button in order to start the video. 

 Click the Pause button in order to interrupt the video and view a still picture. 

 Drag the Slide button to the left or right, to move the video to a desired position. 

 Click the Stop button in order to stop the video. 

 To show the transcript, drag the Eye button to grey field on the right. 

To operate the video, you can now also use the Model Play button in the tool bar. 

 To start the video at a specific point, drag the Model Play button to the corresponding 
passage in the transcript. 

Speak and record the text 
You can speak and record the video text and compare your recording with the model (see Speak and 
record the text and Compare recording with model in chapter 2.2.2 Text comprehension exercise) 
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Access a translation 

 If the Translation button is activated, you can access a written translation of the transcript to 
ensure that you fully understand the video. Drag the Translation button to a text passage of 
the transcript. The translation will appear in a text field on the top of the page. 

Activate Hyperlinks and Look up Words 

 If the Hyperlink button is activated, certain words or passages in the transcript, so-called 
hotwords, will be linked to explanations or exercises. Click on the Hyperlink button in order 
to activate the hotwords (see also Activate Hyperlinks in chapter 2.2.1). 

If a dictionary has been linked to your package, you can look up words by clicking on a word with the 
right mouse button (see also chapter 2.2.9 Access a Dictionary). 
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2.2.4 Text Production Exercises 
The text production template can be used for all kinds of writing exercises like letter writing, faxes, 
memos, reports, summaries etc. The example below, for instance, illustrates a translation exercise. 

 
 Text Production Exercise 

Read task description 
Read the instructions above and in the text field on the left side of the screen. 

Prompts 

 If you click the Prompts button, a text field will appear on the top of the page containing 
information that will help you to perform the given task. 

Write and record 
To perform the given task, write into the text field on the right side of the screen. 

 In order to record an oral answer, drag the Record button to the answer field, speak into the 
microphone, and click on Stop in order to stop the recording. 

 If you want to listen to your recording, drag the Learner Play button to the answer field. Click 
on Stop, if you want to interrupt the playback. 

Access a model solution 

 If the Solution button is activated, you can access a solution. If you drag the Solution button 
to the answer field, a model answer will appear in a text field at the top of the page. 

Save your performance as a text file 

 By clicking on the Disk button, you can save your text as a text file on hard disk or diskette. 
The text file can be edited or printed with any word processor. 

© LINK 1997-2004  17 of 26 



Telos Language Partner TLP Viewer User Manual 

2.2.5 Question-Answer Exercises 
Question-answer exercises consist of an instruction and a visual aid on the left side of the page and a 
question (or task description) and an answer field on the right side of the page. 

 

Answer field 

 Question-Answer Exercise 

Read the question 
Read the question or task description. 

 If the Model Play button is activated, you can also listen to the question or task description 
by dragging the button to the respective text field. 

Access prompts 

 If you click the Prompts button, a text field will appear on the top of the page containing 
information that will help you to perform the given task. 

Answer the question 
You can give the answer in a written and/or spoken form. Write the answer into the answer field. 

 In order to record an oral answer, drag the Record button to the answer field, speak into 
the microphone, and click on Stop in order to stop the recording. 

 If you want to listen to your recording, drag the Learner Play button to the answer field. Click 
on Stop, if you want to interrupt the playback. 

Access a solution 

 If the Solution button is activated, you can access a solution. Drag the Solution button to the 
answer field. A solution will appear in a text field at the top of the page. 

 To access an oral solution, drag the Model Play button to the answer field. 
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Save your performance as a text file 

 By clicking on the Disk button, you can save your text as a text file on hard disk or diskette. 
The text file can be edited or printed with any word processor. 
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2.2.6 Gap-filling exercises 
The gap filling exercises can be used for a wide range of learning activities from listening 
comprehension to grammatical and lexical exercises. 

 
 Gap-filling Exercise 

Fill in all the gaps of the selected gap-filling exercise. To fill in a gap, click onto the gap and fill in the 
missing word(s) or letters. Press the Tab key to go to the next gap. 

If the Sound Operation Panel is activated, the exercise is supported by sound. Use the buttons on 
panel, to play the sound and follow the course instructions (see also Push buttons in chapter 2.1.5). 

 
 Sound Operation Panel 

 To check your answers, drag the Check button and either place it onto the text field or 
directly onto an entry. 

 Your entry will turn green if it is correct; in case it differs from the expected answer, the 
deviating letters will be marked in red. 

 Entries that are marked in red do not correspond to the expected solution. 

 To delete an entry, drag the Erase button to the entry and try again. If you drag the Erase 
button onto the text field, all entries will be deleted. 

 To see the expected answer, drag the Solution button onto the text field or onto an entry. 

 Click on the Scoring button to see what score you have reached. 
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2.2.7 Select-exercises 
The select-exercises are a variant of the gap-filling exercises. However, here the learners do not write 
in the gaps, rather they have to select the correct answer from a list of possible choices. 

Click on the small arrow next to the gap, and a list of possible answers will appear. To choose an 
answer, click on the desired solution and it will appear in the gap. 

 
Select-exercise 

If the Sound Operation Panel is activated, the exercise is supported by sound. Use the buttons on the 
panel, to play the sound and follow the course instructions (see also Push buttons in chapter 3.1.5). 

 
 Sound Operation Panel 

 To check your answers, drag the Check button and either place it onto the text field or 
directly onto an entry. 

 Your entry will turn green if it is correct; in case it differs from the expected answer, the 
deviating letters will be marked in red. 

 Entries that are marked in red do not correspond to the expected solution. 

 To delete an entry, drag the Erase button to the entry and try again. If you drag the Erase 
button onto the text field, all entries will be deleted. 

 To see the expected answer, drag the Solution button onto the text field or onto an entry. 

 Click on the Scoring button to see what score you have reached. 
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2.2.8 Drag&Drop Exercises 
Select a text button from the right side of the page and drag it into the correct space in the text field. 

    
Drag&Drop exercises 

If the Sound Operation Panel is activated, the exercise is supported by sound. Use the buttons on the 
panel, to play the sound and follow the course instructions (see also Push buttons in chapter 2.1.5). 

 
 Sound Operation Panel 

 To check your answers, drag the Check button to an entry or onto the text field. Your entry 
will turn green if it is correct; in case it differs from the expected answer, it will be marked in 
red. 

 To delete an entry, drag the Erase button to the entry and try again. If you drag the Erase 
button onto the text field, all entries will be deleted. 

 To see the correct answer, drag the Solution button onto the text field or onto an entry. 

 Click on the Scoring button to see what score you have reached. 
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2.2.9 Multiple Choice exercises 
To select an answer, click into the corresponding click box. 

 
 Multiple Choice Exercise 

If the Sound Operation Panel is activated, the exercise is supported by sound. Use the buttons on the 
panel, to play the sound and follow the course instructions (see also chapter 3.1.5). 

 
 Sound Operation Panel 

 Click the Check button to check your selections. 

 Click the Solution button to see the correct selections. 

 To delete an entry, drag the Erase button onto the text field or directly onto a click box and 
try again.  
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2.2.10 Explanations 
Learning packages may contain grammatical, lexical, pragmatic or cultural explanations. Explanations 
can usually be accessed through the Contents page and they may also be linked to corresponding 
elements of texts or dialogues. 

 
 Grammatical Explanation 

If the Sound Operation Panel is activated, the explanation is supported by sound. 

 
 Sound Operation Panel 

Use the buttons on the Sound Operation Panel, to play the sound (see also Push Buttons in chapter 
2.1.5). 

Note that in some learning packages the explanation template may also be used for listening 
comprehension exercises. 
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2.2.11 Access a Dictionary 
If a dictionary has been linked to your package, you can look up words by clicking on a word with the 
right mouse button. 

 
 Dictionary Entry 

You can also access the dictionary with the command Dictionary in the Extras menu. Click on the 
appropriate letter of the displayed alphabet and scroll through the word list on the right. To open an 
entry, click on the word of choice. You can also type the word into the space underneath the alphabet. 

2.2.12 Taking Notes 
Use the TLP-Notepad for taking notes and writing down relevant words or phrases. 

To open the notepad, click Notepad in the Extras menu. • 

To save your notes, click Save in the File menu, select a directory, enter a file name and click OK 
(or Save). Your notes will be saved as a text file. 

• 

To print your notes, click Print in the File menu. • 
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3. INFORMATION ON TLP Pro 
TLP Viewer can only be used to run learning packages which were created with the Pro version of 
Telos Language Partner (TLP Pro). TLP Pro is a multimedia learning shell with a learning and an 
editing mode supporting and integrating a range of prototypical language learning activities from 
video-based activities, dialogue practice, text comprehension and production to lexical and 
grammatical explanations and exercises, cultural notes and lexical look-up. 

In the Learning Mode TLP Pro has the same functions as TLP Viewer. 

In addition, TLP Pro includes an Editing Mode, which enables tutors to create customised learning 
packages. 

Tutors can create and edit exercises using the following templates: 

a video template for playing video clips supported by transcript, translation and look-up facilities; • 

• 

• 

• 

• 

• 

• 

• 

a dialogue template either with head pictures or with a situation picture and balloons; 

text comprehension templates with or without the support of an image; 

a text production template which can be used for a range of writing exercises (e.g. writing letters, 
faxes, memos, reports); 

a flexible question-answer template for different kinds of written and/or oral tasks (from 
answering questions and describing pictures to simulating a presentation); 

a gap-filling template for different kinds of exercises from gap-filling to reformulation or sentence 
composition; 

a drag&drop template; 

templates for lexical, grammatical, pragmatic or cultural explanations. 

The Editing Mode also provides a facility to customise and integrate internal dictionaries as well as 
an option for creating hyperlinks between dialogues/texts and lexical, grammatical, pragmatic or 
cultural explanations or exercises. 

Tutors can use these functions to create and customise learning packages to meet the specific needs 
of their target learner groups. 

The Editing Mode can also be used by learners to explore communicative situations and to create 
their own exercises or their own dictionary. 
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